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About Zeus
Zeus is Ireland’s first private e-Referrals and communications platform allowing GP’s, Consultants

and Hospitals to seamlessly refer and discharge patients and reduce admin costs in a fully safe,
secure and traceable environment.

Zeus Referral Process

Response
5 Referral
Messages

Consultant /

Hospital

Why choose Zeus?

Data Security - All referral communication is managed within the secure Zeus platform which
negates the need for posted, faxed or emailed referral /discharge letters and eliminates the
likelihood of mislaid patient information. As information is electronically sent directly from the
patient’s chart, the integrity of patient data is unaffected by inaccurate transcriptions or illegible
handwriting.

Reduced Costs - Removing the reliance on posted referral and discharge letters eradicates a
significant administrative cost. Sending or receiving a referral using Zeus requires No printing,
transcribing, envelope stuffing, franking or postage.

Communication — Zeus Referrals enables GP’s to see in real time whether their referral has been
accepted or delined by the Consultant or Hospital department and in turn whether the patient
attends their scheduled appointment. Upon discharge, the GP receives an instant discharge
notification directly to their desktop ensuring the patient’s file is always up to date.

Patient Experience - Zeus Referrals improves the patient experience by removing the time delay;
patients receive the earliest possible appointment date. Also, patients can be confident the
Consultant is in possession of their most recent and accurate notes. Thirdly, as all referral
information is communicated via the Zeus platform, patient data remains 100% secure and
confidential.

V3.0 2
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Socrates GP - Zeus Referrals

1.1 Registration

In order to use Zeus Referrals you must have one Practice Zeus Account and a GP Zeus Account for
each GP in the Practice. You can register for both accounts in Socrates GP. Any user can register the
Practice Zeus Account but a GP User must register/sign-in to their Zeus GP Account through Socrates
GP in order to link their Socrates Log On to the Zeus GP Account.

1.1.1 Step 1: Register Zeus Practice
1. Click the Practice Sign Up button on the Socrates Home Page.

‘ PRACTICE SIGN UP

2. Alternatively, click the ‘Sign Up’ link on the Socrates GP Home screen to register your
Practice.

& | SignUp | 3 Notifications

e

| S)2RIU0

3. Ensure you enter the Practice Email and choose a Password.

Nota: Cnre youl have regst=red your Practes & saved your 7ens Praches eredeniizls in Socrates yoil can then create 7ens GF Acconnts

s Practice Registration Form

Practice Account Details

Praclice Emsil practice@rensreferas e Confitr Enral

Your emai acdress wil be your usernzms.

Password Confirm cassword

Passvroids must conlsin an upeer case
eller did = dugil

Practice Contact Details

Farne Socrates |lezlthears

Address 4 Protek HoLss Fhore 0719749007
Addiess 2 Finisklin Gusiness Park Fax 719400500
Address 0 Sligz Town Wensite

Courty | Sigo E PostioTe

Areyouasingeuser 1080 NG © WhATE Iy

oractice? Plezse sgeciy TS S 3 Sincle user
practice oy seecting YE& of Ho

Terms and Conditions

! agrzc iz e (orms of Usc and 'rivacy 1'2hzy
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4. For asingle user practice you can create one account (email address) to use as the Zeus
Practice and the Zeus GP account.

Are you a single user Yes g No @ What's this?

practice? Please specify if this is a single user
practice by selecting Yes or No

5. Once you select that you are a single user practice you can add the GP’s name and Medical

Council Number.

GP Details

il |D_r E‘\, GP Name ‘Jim Smith v

Medical Council | 666999 ‘V
Number

6. Agree to the Terms of Use and Privacy Policy and click Register.

Terms and Conditions

[F]| agree to the Terms of Use and Privacy Policy

7. After Registration the Login page will be displayed directing you to check the email account
used during registration for the Zeus Referrals Registration Confirmation Email.

DO NOT CLOSE THIS WINDOW

Step 1: You will receive an email shortly to authenticatz your account. Please click on the link provided in the email to activate your

account

Step 2: Click Login button below to sign in. This will ink your Socrates Account with your Zeus Account

V3.0
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8. When you receive the Zeus Referrals Welcome Email from Zeus click Confirm to
validate your email address. You will then receive a confirmation email.

Hemqiatrzhion Fmar 1ok »

Welcome to Zeus Referrals!

Hellz Serratea Henlthenrs

A feus Reter=ls socount nas bees created =0 you

lo cenhimn yous aczcun: clck 27 the buttas provided Selow.

thanks,

Confirm

9. In Socrates GP click Login and enter the username (email address) &

password that you chose during Practice Registration.

10. Your Practice Zeus Account details are now stored in Socrates GP.

1.1.2 Step 2: Register Zeus GP (GP User only)

1. When you have completed step 1: Practice Zeus Account you will be presented with the
k. Dont have Zeus GP Accourt? Sign Up

Zeus GP Sign-In form. Click the Sign Up lin

& Enter Zeus Credentials =

Please Enter your Zeus GP Credentials

Username: | Q
Password: Q
Donthave Zeue GP fccount?Sentp | OK || Concel |

% ]

2. ORIf the Practice account has already been set up then click the Sign Up Now

‘ SIGN UP NOW

button on the Socrates Home Page. Alternatively click the ‘Sign Up’

link on the Socrates GP Home screen

O [ sSignUp | 3 Notifications

%

S10RIUOT
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3. Confirm your details on the form and choose a password.

Z Zeus GP Registration Form

" Account Details

Email ‘ paul johnson@zeus.com ‘ v Confirm Email ‘ paul johnson@zeus.com ‘ v’

Your email address will be your username.

Password ‘ """"" ‘ v Confirm password ‘ """"" | ‘ v

Passwords must contain an upper case letter
and a digit.

Your Details

Title ‘ Dr. [~] ‘ v Full name | Paul Johnson

MCN (Medical Council 085652
Number)

4. Agree to the Terms of Use and Privacy Policy and click Register.
Terms and Conditions

[F7]1 agree to the Terms of Use and Privacy Policy

5. When you receive the Zeus Referrals Welcome Email click Confirm to validate your
email address. You will then receive a confirmation email.

Reqistratcn Cmail 1 2F 2

[ ]

Welcome to Zeus Referrals!

6. In Socrates GP click Login and enter the username & password that you

chose during the Zeus GP Registration.

7. Your Zeus GP account is now linked to your Socrates GP user account.

1.1.3 Single User Practice
If you have registered for a Single User Account then you need to enter your Username (email
address) and password for both the Practice Login and the GP Login.

V3.0 6
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1.2 Send Zeus Referral

1.2.1 Zeus Referral Letter

GP Overview Manual

1. Begin a Consultation for the patient and navigate to the Documents section and to the

Letters subcategory.

2. Select Add Letter or click the Add button.

Consultation &

e Daaliml, Frave
S5 Comaitation Delals % & 1 orchard Road. Dublin,

: e UnfUn19EL (1S yra @) Hale

J Faliling:

012563895

Frevate

Cmsullabon - Zews Paoonl
U3y 014 1423/ by Faul Johnson
V00000

PR | 000

Completa

| ale Coag aileny | [apagdy  seawen |

3. If you are a non-gp user you can complete a Zeus Referral letter and send it on behalf of any
registered Zeus GP once the GP has entered his/her Zeus GP Credentials in Socrates GP.

4. Click ... = button on Selected Reference to open the Search dialog.

o]

Add Letter

bl Patient, Zeus

Letter Date: | 030372014 [=

Letter Type: (Leter -]

Refer To: [Edemal Contact -

Selected Reference |
Lefter Template: | -]
Healthcare Pro:  [paul Johnson -]
Description: l ]

[0k [ cancel |

5. Click Zeus Online Search from the left hand menu.

ol Ertemal Contact Searcr T~ ® - Y

Zeus Online Search

V3.0

| Scarch
Type IALL TYPES ,I Sunzme | _ Search
Company 1 First | [ Tew I
Local Contacta ' L
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Note: You can select the Zeus Online Search as your default Search in Edit > Preferences.

= Select Web Features and check Use Zeus Search By Default.

LClent U'reberences | =] B |

Web Features

Viab Features

[¥ Sihovae Vien Hsterencas Hines Harn Cortmonicabon
=

[¥ Showe Ze s S gron a0 mom wandowe

w2 7 s Zous Szach By Defact |
= Lozd Zous Home On Stomup
Cormunicat ong . ”
@ et=ul & Yes @ No
.,-—""_'?

o]

6. Search for the Service Provider by entering the Service Providers name in the Search field

and click ﬂ or press the enter key on the keyboard. Use the filters e.g. Hospital, Speciality
etc to narrow your search.

g z Eus Shaac| 10 = e caniles [ AEmancal [ =collepe s

Jack Smith n G

“Hospitals .
1. Jack Similh AYG Time 90 davis) m - Eefer
‘Spacialitias
¢ Departments st b m
¢ Counties Cardialogy (1)
W1 Jack Simith AYG Time 30 davis) & view | | * Acd | e
Snowing 2 ot Zreccrds Pagss: Frevious ' hzxt

7. To see additional information on the Institution or Service Provider before referring the

patient click the View button. You can also select the Service Provider’'s Name.

W Add
8. Click the Add button beside the chosen Service Provider to add this Service

Provider to your Favourites list.

| # Favourites

9. Click the Favourites button to view your Favourites.

™ Defer
10. Click the Refer button beside the chosen Service Provider to proceed.

V3.0 8
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11. Select the Letter Template. If you are sending the letter on behalf of a GP registered on Zeus
select the GP from the Zeus GP User dropdown list and click OK.

Add Letter
Letter Date: 0510572014 [=]
Letter Type: [Lﬂ.ﬁ' v]
Refer To: [m':m .]
Selected Refersnce | mr Frank Spence [l
Letter Template: |1, Gtandand Refemal -
Healthcars Pro: [ﬁme Administration v]
Description:
Zeus GP User [Paut Johnson - |
[See Attached lefter]
Referral Reasan
Referal Priorty @ Foutine Urgant

12. If the Service Provider requires a signature image on the Referral you will receive the
following notification.

[ Signature Required [EJ ﬂ )

& Asignature is required.
If a signature image is not included the recipient may decline the
referral.

This can be added by selecting Picture from the Insert menu in
Microsoft Word.

Note: How to Insert a Scanned Signature Image

= Place the cursor at the correct position in the document.

= |nthe Microsoft Word letter click Insert and select Picture.

File Home Insert Page Layout

w | I }i:"—j 1 | [EE
= =] = Vil |FRE]
Cover EBlank Page Table Picture | Clip

Page~ Page Break o Art
Pages Tables

= Browse to the directory where you have saved the Signature image and select it.

13. Close Microsoft Word.

V3.0 9
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14. You will be presented with a dialog box to attach Socrates Documents and you can send the
Zeus Referral now or later.

-
Send Zeus Referral

Send Zeus Referral

Add Attachments: Attach File

F Send Now ‘D Send Later ‘

L% -

15. If you choose Send Now, you will receive a confirmation message when the Referral has
been sent.

7

Referral Sent Successfully

+ Zeus Referral
W Referral Sent Successfully

Close

[

16. The Zeus Referral letter is saved in the Letters subcategory in Documents.

Consultation Pabient, fens [EFEmnng:  USLUFSULY LTUY DY P JONNSon
1 0rchard Road, Cublin, 012563595087 2211212 0000007
85051995 (19 yr 5 ] Mtk Privale P-1L00 FFL0N

Lellers

# Clear Fiter(z)
Rufeual -

Torniplate Status

3 Emal Patent

Ay Add Leder
& Lt eder
i eder
) Mmoo hedrad
=5 Ewee | Lede

5 Sean Documzr

‘@ Sketzh Drawng

V3.0 10
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17. The Zeus Referral is saved in the E-Referrals subcategory in Documents with a status of
Delivered. The E-Referrals section displays all electronic referrals and their responses.

Conaultation I'atient, Lous L& EdiEing: UYL LULE LHUY DY P JONNSON
. 1 firchard Road, Mebiin, 017563R95/N&TFF 11713 NOHO0NT
05/05/1995 (19 yr 5 m] Male Private PE0.00 FE0.00

|y
“n TmmimisAtinne b

-
= 23 Leters
L""
==
- el
Diozurents

Ef Crail “otent

9‘- A Leller
i e
B il el
3 Opeerin addanl
ES Sl Hie E
3 Scan Document E-Reerralz

% Sketch Crawing

18. If you click Send Later, the Referral will be saved to the Documents > E-Referrals
subcategory with a status of Not Sent. Any Failed Zeus Referrals will be saved with a status
of Delivery Failed.

19. To resubmit a zeus referral, select the referral and click Re-Submit.

Consultation Eatient, feus L Editing: W)L ANE 20 DY A NSO
1 0rcliard Ruad, Dublin, 012563895 /0872211212 0000007
u 05/05/1995 {19 yr 5m}

%pnr m: Qﬂl“w:.;.,..fdlg .

ES) Email Psfiert

By Add Leter

&8 Fdir | ater

%@ Print Letter

1 Opzn i Viordpad
E5 Bl Laller

= Gean Document

% Sketeh Drowing

20. All Unsent Zeus Referrals will be displayed in the Document Reviewer in My Control Panel.

1.2.2 Delete Zeus Referral
1. In the event that you create a Zeus Referral by mistake, you can delete any Unsent Zeus
Referrals from the E-Referrals subcategory in Documents.

%ﬂ

Deacripton

=
e |

E-F.{ul ak

2. You can delete the Zeus Referral Letter from the Letters subcategory in Documents
V3.0 11
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1.2.3 Unsent Zeus Referral
1. Anyunsent referrals will be displayed in Socrates Notifications.

1 Result in Review
. 4 Unread Referral Responses
.| 1 Referral not Delivered

. 2 Overdue Referrals
e

@ 1 Unsent Zeus Referral

2. Select the Zeus Referral and click Edit :E— to preview or edit the letter.

w8 T Dzl uld Duew el s e Sl |
Do B avie
Diocmesisl R
@ InRoviow Addre . 0
@ Frvicared
& vicw Crnuiemine s BB Fr = Tk |
@ e - n
Paivrd | [l 4ZP Padichnzn z Mide [wmene -] [ 5]
@ [PNL15 | 7o Peeomi tn dook Smich Foin Pntien Faut doh-aon
T |omurents n4suey  Added by Fau Jobrszn ALY 1l

3. Click Zeus Send to add attachments or to Send the Zeus Referral.

Send Zeus Referral

Send Zeus Referral

Add Attachments: Attach File

@ Send Later ‘ [ Send Now

V3.0 12
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4. Click Attach File to add attachments (PDF, JPEG, PNG or GIF) from Socrates Documents.

L

IZ-':‘s;:l.'i;ti.-:

oz [ zme | [riseeeen] [ rin | | Mewsees | | Sesibee | | ssschrie |

5. Click Attach File in the Document Manager to attach a file from your computer / network to
this patients chart.

6. Click Attach Document [Q»_.;jkgg,._,_.__*_,.ﬁ "E"-Q']to attach the file to your Zeus Referral.

7. Click Send Now """ Jor click Send Later L J. The Zeus Referral will stay in the

Document Reviewer until it is sent or until it is deleted in the patients chart.

V3.0 13
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1.3 Download Zeus Referral Responses

1.3.1 Download Responses
1. To download your Zeus messages go to Communication and select Lab Messaging.

.- H U Lab Messaging

2. Click Download Electronic Messages.

\k Download HL7 Files from the Internet

; Download Electronic Messages...

3. On the Zeus Downloader click the Download button.

'© ZEUS! |
' REFERRALS |7 Show Detsie (O vownioss || cose |

4. The matched referral response messages are saved to the patients chart and is displayed in
the Result Viewer.

Download complete | 2 downloaded | 1 unmatched

S ZEUS

REFERRALS [& e oeis (O oowcas | |4 cose |

Logging in....

Downloading data from feus....

Discharge for Smith, Evan from Mr. Frank Spence to MCN 085652

Refemal Response for Patient, Zeus from Mr. Frank Spence to MCMN 085652
Total downloads: 2

Tatal unmatched: 1

V3.0 14
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1.3.2 Unmatched Responses

1. Any unmatched referrals will be displayed in the Details section. Click on the Match
Responses button to match these referral responses.

Bosnlcading E

Mlati i e B

& ZEUS

REFERRALS [& téepaas O oot | [ oo |

Logging in....

Downloading data from Zeus....

Discharge for Smith, Evan from Mr. Frank Spence to MCN 085652

Referal Response for Patient, Zeus from Mr. Frank Spence to MCN 085652
Total downloads: 2

Total unmatched: 1

Download complete | 2 downloaded | 1 unmatched

l &5 Match Responses

% Find Patient
2. Select the response message and click the Find Patient button to search for

the patient.

=] == | )

Ferily Coclails

Name:  Smith, Bvan Nat: scheme:  Momc

Match zeus Responses Age: ayram DeFHLH:  Paul Johnson 1ypa: Frivate

Unique ¢ 0009005

From | To CH | P Firstamc
Mr. | rark Spence Ur. Ve Sobrso Lvaa

Defaut HZ™

Patient Typz

Ltk | e3e01T [=] WS inctor [ =

Uniqu= Mo LIRS Nurmher

Chart Mumber

Malch Palivnl

gﬂ Paul Jehnson 2 & 5 Find Palignl

V3.0 15
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3. Double click to select the patient from the list returned or click the NEW button to register &
match this response to a new patient.

it REW B
i — om—

Match Zeus Responses

i Mes | From | To To MCN _I P Firstname J P Lastname | DOB Address 1
Evan

i AD3  Mr. Frank Spence Dr. Paul Johnso 085652 Smith 05/05/2010 1 Orchard Drive

Match GP Match Patient

& ‘3&. Find Patient ‘

1D: 20061
Name: Smith,Evan
DOB: 05/05/10
Address: 1 Orchard Drive

4. Click Save button to save the referral response message to the selected patient.

5. Click Close when finished.

V3.0 16
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1.3.3 View Referral Responses
1. Click on the Notification centre (top right) to view all new notifications. (GP User)

2. Click the Unread Referral Responses which will bring you directly to the Result Viewer /
Referral Response Messages (In Review) tab.

B (VR O

b | 1 Notification |

[= | S Unread Referral Responses
t—— u
: =

3. Alternatively, go to My Control Panel > Result Viewer and select the Referral Response
Messages tab

4. Click on the message to preview the referral response.

Edit Accourts dindoe Hel
Cantrol Pansl i e Viewet

sed Referral Response Messages

Rame: o 1 Fm)

B 2 Wl
[

ney

B

] . Referral Accepted

Artrirnen
D1 Fad Jehrezn

e Document Date: 10/12/2013
HAE

v o ] o Referral Status Referral From Referring To

12wt
7 by Frogeae
e Statin: Acceptod

Date: 1012:2013 Dir Pawl Jobreon Mr. Frank Spence

24 HOUR SO0 FR
ETT
Aad

Patient Details

Name Address Phone

Zens 1 Crchard Road 01 23568956
Pt Dhibbe DETIIET4S
DOB: 01051350

Notes

Thank you for the refirral Appomtment confirmaton will Blow stoatly. Regands Dy Frask Spemce

5. To view any accompanying attachments click View Attachments.

6. Any response where the Service Provider has indicated that there is a significant finding will
be displayed with a red asterisk in the Result Viewer.

Processed Referral Response Messages

NAame: Patient, feus THI: Ui 149490 (28 yr 1 m)

Address: 1 The Orchard, Dublin Phone:  H: DI2568065M: 0875212313

Lo scharge Mezsngea 1l Apagirtman; Massazes (1 Hetzma |tzazense Mzasazes (10

Referral Accepted

Toenment Dare: 28012015

kdark as Read

7. Click Mark as Read to remove the response message from the viewer.

Assighn Task
8. Click Assign Task to add a task for yourself or another member of staff.

V3.0 17
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1.3.4 Patients Chart
1. To view the patients chart click the Open Consultation button from the Viewer Menu on the

left hand side or open the chart from Consultation-@k. £l ]

Tfa Clear Filters

Open Consulkation

2. In Consultation Details the original referral will show the most up to date status of the
Referral. Double click on the referral to preview the original referral document.

Ll [t Ae-aunts Ten o Tamer - & P HasHiratang
3 2 e | sk, (") Hod W Ed Lo lda Sow=da ¥ 4

Eulivul, oy S viewing 107132013 104 by O Maol Jahnzan E

Consukcation Detalls. & & L Dnchaid aad. Dubin. L 23500955 MTEF 745 THDODI 37T =
B b T MR o) Male i AL L - |
Ve oy POMN L bayry: [2Lo =l [ el G ENEM @ v woE
B R N TR\ i :
= ML WA Do) [T Lo I e 0w UM g as —n i
" e RN T TR Y] 2

i

#

5

P | M calinens

BT deml 3% PRz aRULLLE Ik, Haped
B2 ACW: 3 7" b PO R T e ) Fingrnd

3. Double click on the E-Response to preview the response message.

4. Select Documents and the E-Referrals subcategory to view all e-Referrals and their

ik Sorataten CuitorsTaors Winden Le B 7 Hanficatinns
& Lusmmri i Lenbs |z Lelibs sezarny |l el Vi % Luigaldin - S Felren, |'F. e
Fatient, Jeus FEviewing: IR T30 13 10T e e il ks :
& 1 wrhawd Ao, Dohbding N1 ZZRRANSRNRTASIRTAS TINNMIRTT g_
) 010S/1990{ZIyr Tk Male Privale PN FE0.00 < [
I
1%
; %3 5
£
x
e T
o IrFad drbacen
=] :
)
20 21 i Potin,
[zcumert

£y 2t it =5
T oadibdls \ﬁ
S rrilety

T2 Jpsi rvicicped

ES Zrcicbome A—
= e Mos e ;%
=g

wk ghadl L=y

= e

5. Click on + button beside the referral to view all Zeus response messages. If the response
message contains an attachment you will see a paperclip icon in the View Message button.

6. Click the View Message button to view the response message.
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1.4 GP Portal
1. In Socrates GP the Zeus Home page should load by default as your new Socrates GP Home

Page.
2. To access your Zeus Portal outside of Socrates GP go to http://www.zeusreferrals.com and
. _ Login » .
Click the Login button and enter your username (email address) and the

password that you chose during registration.

Call us Today (071) 9193600 [ info@zeusreferrals.com

& ZEUS ogn > S

REFERRALS

B

1.4.1 Home
The Zeus home page will be used to provide you with all the latest News & Events.

Events 3 I =

Everls Coming Soor... Serd elzclron e Mivale Refzrrals fom
the zatents chart Now!

O ZEUS -

REFERRALS iy ek sruseforals

Details on -2 Event will be posted he e

waw ceusieienal Lo

Socrates GP Y207 0 User Manuzl
B2 howrsage W Added by Socrates ifealtheare
I3
socrates &

- r o by Luping Laie o
V202,00 User Manual 48 e

and asung Intemet Cxplcrar, Gocgle
Cnrommes hE ow e 3200 atas e IE2HME NUE

oo e

1.4.2 Profile
Click Profile to view the details entered during registration. Click the edit button to amend any

details and Save.

Your Profile

Home

_ Home » Profile
Profile

Directory Search

, & Profile
My Favourites

Title
Manage Account or.

Name Paul Johnson

Help

Medical Council # 085652

V3.0 19
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1.4.3 Directory Search

Search the Service Provider directory and click Add button to add the service

provider to your Favourites.

Directory Search

Home

Home > Diractory search

sine thiomlon n

“Hospitals

Profile

D rcctory Scerch

showe 10 |l * Favourites ” =+ Exoand All ” = Colapsc All

1zna
“Specialities s/ Albrn Hospital (1)

1i=lp

E Mlergy Medidne
[E #nacsthesia / Main Managoment Allergy Medicine (1)
[ Creast Surgery

- Cardiclogy .
[ Fardiotharacic Surgery prof. Sine Thomen & View

[ Chileh s Acloles el Paye hiatry
[ Colorectal surgary

[ Dermatology

[E Uisgnostic Imzging

[E Dietetics .
[= Ear Mosc &% Throat Medicine Allergy Medicine (1)
[ Gastroenterology

T Sty B fmdinimn

~s Bandon Community Hospltal [1]

Prof, sine ihormicn AV lime 10 dayl(s)

& Viewr | * ade

* Departments

< Counties showing & of & records Hages: o

1.4.4 My Favourites
View your favourite list of service providers.

My Favourites

Hinre

Home > My Fevourites

Frofile
plise Infel acd o vour favourites using the Saarch Diractory
My Favourlzes
* My Favouriles
Managc &ccount
Help Lonsultant Hospital Specialities & Details @ Remcve
Mr. Frark Sperce Taus Privata Hospital Card ology s i
View Hemove

& Raturn to Homa = Search for Favourr

1. Click Ittt VTSN button to search the directory and click Add button
to add the service provider to your Favourites.

]

2. Toremove a Service Provider from your Favourites click Remove button. Remove
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1.4.5 Manage Account
To change your password click Manage Account.

Manage Account

Home

_ Home > Manage Account
Profile

& Change Password

Directory Search

My Favourites Current password Current Password

Manage Account

New password Mew Passw
Help Passwords must contain an upper case letter and a digit.
Confirm new password Confirm New Password

{© Cancel | = Change password
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